Table Of Contents

1 Welcome to ABSYNTH 5!........................................................................................................5
  1.1 What’s New in ABSYNTH 5?.......................................................................................... 5
  1.2 The ABSYNTH 5 Documentation.................................................................................. 6
    1.2.1 In this Manual........................................................................................................ 6
    1.2.2 Other Documentation............................................................................................ 6
    1.2.3 Formatting Conventions........................................................................................ 6
  1.3 System Requirements.................................................................................................... 7
2 Setup ................................................................................................................................... 8
  2.1 Setting up ABSYNTH 5 in Stand-Alone Mode.............................................................. 8
    2.1.1 Audio and MIDI Settings......................................................................................... 8
    2.1.2 About Latencies...................................................................................................... 9
    2.1.3 The MIDI Hardware............................................................................................... 10
  2.2 ABSYNTH 5 as a Plug-in.................................................................................................. 11
3 ABSYNTH 5 Overview ...................................................................................................... 12
  3.1 The Idea behind ABSYNTH 5 ..................................................................................... 12
    3.1.1 Semi-Modular Design............................................................................................ 12
    3.1.2 Modulation............................................................................................................ 13
    3.1.3 Macro Controls...................................................................................................... 13
    3.1.4 Waveforms........................................................................................................... 14
    3.1.5 The Mutator........................................................................................................... 15
  3.2 The User Interface ......................................................................................................... 15
    3.2.1 Navigation Bar ....................................................................................................... 16
    3.2.2 Browser Window .................................................................................................. 17
    3.2.3 Attributes Window ............................................................................................... 18
    3.2.4 Perform Window ................................................................................................... 19
    3.2.5 Patch Window ...................................................................................................... 20
    3.2.6 Effect Window ..................................................................................................... 21
    3.2.7 Wave Window ...................................................................................................... 22
    3.2.8 Envelope Window................................................................................................. 23
    3.2.9 LFO Window ........................................................................................................ 24
4 Quick Starts ..................................................................................................................... 25
  4.1 Finding and Loading Sounds ....................................................................................... 25
    4.1.1 The Plan ................................................................................................................ 26
    4.1.2 The Browser .......................................................................................................... 26
    4.1.3 Finding the Right Sound ....................................................................................... 27
    4.1.4 Using the Search Field ......................................................................................... 28
    4.1.5 Always available .................................................................................................. 28
<table>
<thead>
<tr>
<th>Section</th>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2</td>
<td>Mutate Your Sounds!</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>4.2.1 Choosing the Right Direction</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>4.2.2 Two Sliders, Two Buttons</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>4.2.3 Refining Your Mutation</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>4.2.4 Using the History</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>4.2.5 Tips</td>
<td>33</td>
</tr>
<tr>
<td>4.3</td>
<td>Creating Sounds: the Good Old Way</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>4.3.1 Preparations</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>4.3.2 Configuring the First Module</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>4.3.3 Adding other Modules</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>4.3.4 Interlude: Saving Your Sound</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>4.3.5 Modulating the Filter</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>4.3.6 Add Attributes to Your Sound!</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>4.3.7 Useful Tips</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>4.3.8 What Is Next?</td>
<td>45</td>
</tr>
<tr>
<td>4.4</td>
<td>Creating and Morphing Waveforms</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>4.4.1 Creating a Morph Wave</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>4.4.2 Editing the Initial Waveforms</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>4.4.3 Playing with the Morphing</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>4.4.4 What Is Next?</td>
<td>50</td>
</tr>
<tr>
<td>4.5</td>
<td>Introducing the Aetherizer</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>4.5.1 Get ready</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>4.5.2 Setting up the Aetherizer</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>4.5.3 Playing with the Aetherizer</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>4.5.4 What Is Next?</td>
<td>57</td>
</tr>
</tbody>
</table>

Index: 59
1 Welcome to ABSYNTH 5!

We are delighted that you have chosen ABSYNTH 5! ABSYNTH’s semi-modular design allows you to combine oscillators, modulation sources, and filters in any way you want. You can create unusual and dynamic sounds by combining the numerous effects and modulation possibilities in various ways. The new Aetherizer effect and filter feedback bring ABSYNTH 5 to a new level in sound design. You can explore the huge ABSYNTH 5 Factory Library of more than 1700 presets. Moreover, the new Mutator feature allows you to create whole new sounds based on a favorite and the attributes you choose! Dedicated Macro Controls allow you to operate several parameters at the touch of a button or just by pressing one key on your MIDI keyboard, and everything is fully automatable in your audio MIDI sequencer. All this allows you to focus on what this is all about: realizing your musical ideas! We hope you enjoy ABSYNTH 5 as much as we do.

The ABSYNTH 5 Team at Native Instruments.

1.1 What’s New in ABSYNTH 5?

Here is a short overview of the new features in ABSYNTH 5 compared to ABSYNTH 4:

- The Mutator introduces a totally new approach to sound design with ABSYNTH. With the Mutator, you can let ABSYNTH automatically generate new Sounds somewhere between the current Sound and other Sounds from the Library.

- The Aetherizer Effect combines a granular-based feedback with a post-delay section. Moreover, all of its parameters can be both randomized and modulated.

- The Cloud filter is the little brother of the new Aetherizer Effect, for use in the Filter modules within the Patch window.

- The Supercomb filter extends the capacities of the Comb filter (still available), using some of the characteristics of the Resonators and Pipe Effects.

- New feedback loop for many filter types: LPF 2 Pole, LPF 4 Pole, LPF 8 Pole, Supercomb, Allpass 2, Allpass 4, Allpass 8. Filter feedback allows you to insert a sound modulator like a Waveshaper, Frequency Shifter or Ring Modulator in the resonance path, giving your filters custom distortions, even ones never heard before.

- Reorganized Filter, Modulator and Waveshaper modules present a unified interface and propose a new organization for their menus.

- Support for Windows XP/Vista 64-bit operating systems.
1.2 The ABSYNTH 5 Documentation

1.2.1 In this Manual

What you are holding in your hands right now is the Getting Started Manual which will give you an overview of ABSYNTH 5’s main features and functions. This Getting Started Manual is divided into four parts:

• The first part is the introduction you are reading now.
• Chapter 2 “Setup” will help you to set up ABSYNTH 5 on your computer.
• Chapter 3 “ABSYNTH 5 Overview” will introduce you to the main concepts of ABSYNTH 5, giving you the basic understanding of the ABSYNTH 5 “way-of-thinking”. This chapter also provides you with a description of ABSYNTH 5’s user interface and its main areas and control elements.
• Chapter 4 “Quick Starts” is a selection of tutorials that will let you discover how to use the various tools provided by ABSYNTH 5. These practical examples will simplify the learning process, to get you quickly started with designing your own Sounds!

1.2.2 Other Documentation

For more in-depth information on all topics not covered here, please refer to the ABSYNTH 5 Reference Manual which is available as a PDF file in the subfolder “Documentation” of ABSYNTH 5’s installation folder. Alternatively, you can download the Reference Manual from the Update Manager on the Native Instruments Website: www.native-instruments.com

1.2.3 Formatting Conventions

The icons introducing these notes let you see what kind of information is to be expected:

⚠️

Whenever this exclamation mark icon appears, you should read the corresponding note carefully and follow the instructions and hints given there if applicable.
This lightbulb icon indicates that a note contains useful extra information. This information may often help you to solve a task more efficiently, but does not necessarily apply to the setup or operating system you are using. However, it should be worth reading for most users.

1.3 System Requirements

For current information about system requirements and compatibility with current and legacy operating systems, please see our website at: www.native-instruments.com/absynth
2 Setup

This chapter leads you through the necessary steps for setting up your ABSYNTH 5 installation. The first part deals with the stand-alone version of ABSYNTH 5. The second section provides an overview of the available ABSYNTH 5 plug-ins.

2.1 Setting up ABSYNTH 5 in Stand-Alone Mode

ABSYNTH 5 can run as a stand-alone software with its own interface to your audio and MIDI hardware. Use this mode if you only want to play ABSYNTH 5 via a MIDI keyboard/controller attached to your computer or if you want ABSYNTH 5 to receive MIDI data from a piece of software that cannot host any of the available ABSYNTH 5 plug-ins.

2.1.1 Audio and MIDI Settings

Before you start your work with ABSYNTH 5 it is a good idea to configure its audio settings to fit your needs. This only applies to the stand-alone version of ABSYNTH 5 as with the ABSYNTH 5 plug-ins all things audio and MIDI are handled by the host software.

The Audio Hardware

Do the following to set up your audio hardware in ABSYNTH 5:

1. Choose the entry Audio and MIDI Settings… from the File menu in the Application Menu Bar, at the very top of the application’s window. The Audio and MIDI Settings dialog opens:

   ![](image)

   The Audio page of the Audio and MIDI Settings showing a RIG KONTROL 3 as the active audio hardware (Windows version shown).
2. From the Driver menu of the Audio page, select *ASIO* on Windows for best results (on a Mac this will be set to *CoreAudio*, your only choice in Mac OS X).

3. Use the Device menu to select the desired audio interface.

4. We recommend setting the sample rate to 44100 and setting the output latency to about 10 ms. Depending on your hardware this may be done via the Latency Slider on the bottom of the Audio Tab or via the button ASIO Config that opens the control panel of your audio interface.

These are recommended settings that should work well on most computer systems; for information on what these settings mean, please refer to section 2.1.2, “About Latencies.”

### 2.1.2 About Latencies

The data produced by audio software like ABSYNTH 5 has to be handed over to the driver of the currently used audio hardware, which in turn passes it to the digital to analog converters that produce an analog signal to be heard via your speakers. This procedure takes time. The resulting delay is called latency. The high performance level of current computer hardware combined with advances in driver technologies has reduced the required time to a few milliseconds. Still, there is a trade-off to be made, as an extremely low latency taxes the computer resources more than a relaxed setting with a longer delay between sound production in the software and sound reproduction via the speakers. The nature of the driver used is also an important factor in this game.

**Use low-latency drivers**

Whenever possible you should use low-latency drivers while working with ABSYNTH 5. ABSYNTH 5 works with two types of low-latency drivers:

- ASIO drivers
- Core Audio (only on computer running Mac OS X)

These two technologies ensure an efficient data transfer between Software and audio hardware and should provide a latency that is suitable for live play, if not unnoticeable.
2.1.3 The MIDI Hardware

For using ABSYNTH 5 with a MIDI keyboard or controller you have to choose the right MIDI interface so that the MIDI data reaches ABSYNTH 5.

To do this:

1. Open the Audio and MIDI Settings dialog from the File menu.
2. Switch to the MIDI page.

![The MIDI page of the Audio and MIDI Settings showing an active RIG KONTROL 3 MIDI interface (Windows version shown).](image)

3. On the MIDI page, check that the MIDI interface or device you are using is turned on. If you see your interface listed but it is off, click on the Off label to turn it on.

Now you should be able to play ABSYNTH 5 via your MIDI keyboard or controller. If you do not have a MIDI controller available, you can still play MIDI notes by using the computer’s keyboard. We have assigned the four rows of alphanumerical keys in a similar pattern to that of a piano keyboard. For example, the bottom row of keys on your computer keyboard (from [Z] on the left to [/] on the right) is assigned to the white keys of the piano keyboard, with the [Z] key being assigned to C. The row of keys above that (from [S] to [;]) covers the corresponding black keys, with [S] assigned to C#. The two rows of keys above are assigned in a similar pattern, but one octave higher.


2.2 ABSYNTH 5 as a Plug-in

ABSYNTH 5 does not only come as a stand-alone application but also in a variety of plug-in formats for use in hosts like Native Instruments KORE, Steinberg Cubase/Nuendo, Ableton Live, MOTU Digital Performer, Apple Logic or Digidesign Pro Tools®. The synthesis functionality of the ABSYNTH 5 plug-ins is identical to the stand-alone version. However, the plug-ins lack the options for settings up audio and MIDI hardware as this is handled by the host the plug-in is working in.

Plug-in Formats and Hosts
Depending on the operating system running on your computer you have the choice between the following plug-in formats:
• VSTi® (Mac OS X and Windows)
• Audio Unit (Mac OS X only)
• RTAS® (Mac OS X and Windows for use in Digidesign Pro Tools®)

Please refer to the documentation of your host software for details about the required plug-in format and how to open and use the ABSYNTH 5 plug-in.
3 ABSYNTH 5 Overview

3.1 The Idea behind ABSYNTH 5

This section will introduce you to the fundamental concepts behind ABSYNTH 5. This will familiarize you with the way ABSYNTH 5 works and let you catch sight of the power of its design. You will continuously encounter these concepts in your work with ABSYNTH 5. You will find practical examples of how these concepts are implemented in the chapter 4, “Quick Starts.” For an in-depth explanation of all functionality to be found in ABSYNTH 5, please refer to the Reference Manual.

3.1.1 Semi-Modular Design

ABSYNTH 5’s Patch window displays a bunch of so-called Module Slots. You can activate/deactivate any Module Slot by simply clicking on its left border (the thicker one). The audio signal path is depicted by wires that connect the activated modules. This allows you to see at a glance which modules are used in the current Sound.

The Oscillator Channels

Basically, ABSYNTH 5 offers three so-called Oscillator Channels (labeled A, B and C), presented vertically in the top part of the Patch window. Each Channel can hold up to three modules. The signal is flowing from the top to the bottom of each Channel. An Oscillator module always sits at the top of a Channel. The Oscillator modules are the only sound sources in ABSYNTH 5. They provide the foundation for every Sound. At least one of the three Oscillator modules must be activated in order to hear a sound! The two following Module Slots in each Channel can hold any of the 19 sound processing modules, these being of three different types: Filters, Modulators or Waveshapers.

The Master Channel

The signals coming from the three Channels A to C then run together through the Master Channel, laid out horizontally at the bottom of the Patch window—the signal going from left to right. Here also, you can activate up to three modules: The first two Module Slots can hold additional sound processing modules (Filter, Modulator or Waveshaper modules). In the last Module Slot at the far right, you can activate the Effect module, which allows you to make use of the amazing ABSYNTH effects. This module is driven by the separate Effect window.
As you can see, the semi-modular design of ABSYNTH 5 allows you to adapt the structure of your synthesizer to meet your needs. Unlike most hardware synthesizers, ABSYNTH allows you complete flexibility setting up the number and order of the oscillators, filters and other features you wish to use.

3.1.2 Modulation

ABSYNTH is known for its lively, organic sounds that grow and evolve over the time. The backgrounds of these capabilities are the flexible possibilities of modulation in ABSYNTH 5.

A modulation uses a control signal (the modulation source) to let a particular parameter (the modulation target) change its value over time.

To modulate a parameter for the duration of a sound, simply connect this parameter with a modulation source: the modulation source then takes control of the relevant parameter.

There are different modulation sources available within ABSYNTH 5:

- Use LFOs to produce cyclical value sequences, for example to let the amplitude of an oscillator go up and down or to change the cutoff frequency of a filter periodically. ABSYNTH 5 allows you to create LFOs from virtually any kind of waveform (see section “Waveforms” below).
- Use Envelopes to precisely modify the value of a parameter at some particular points (called “break points”) in the sound. ABSYNTH's Envelopes are indeed very powerful tools for shaping your control signals. You will find a practical example of the use of Envelopes at section 4.3.5, “Modulating the Filter.”

LFOs and Envelopes are very flexible modulation sources and hold many parameters. Hence, they both have their own windows.

3.1.3 Macro Controls

The Macro Controls are the interface between ABSYNTH 5 and the MIDI world. They allow you to control most of the ABSYNTH parameters via MIDI, either from a MIDI hardware device or by using sequencer automation. For example, you can raise the filter resonance or move the breakpoints of your envelopes in real time. This can be seen as a sort of “external modulation”: Instead of controlling your parameters via internal LFOs or Envelopes, you control them via external MIDI control signals.

You can even control your internal modulation sources via external MIDI signals, thus combining both external and internal modulations!
The Macro Controls let you define groups of parameters to be controlled from the same MIDI Control Change (CC). This way, you can build powerful MIDI controlling schemes by assigning various pertinent parameters to the same Macro Control. You can then control all the parameters in this group using a single rotary knob on your MIDI hardware controller or an automation track in your sequencer software. Macro Controls, along with all other ABSYNTH's MIDI features, are managed in the dedicated Perform window. All details about ABSYNTH's MIDI functionalities can be found in the Reference Manual.

### 3.1.4 Waveforms

Waveforms play an important role in many areas of ABSYNTH 5: for example, they can serve as sound sources in the Oscillator modules or as building blocks for your LFOs. Basically, a Waveform is a small chunk of signal designed to be looped, thus generating a periodic signal, may it be an audio signal or a control signal. Usual examples are the sine, square, sawtooth and others. Although a large number of readymade Waveforms are available out of the box for immediate use, ABSYNTH 5 does not limit you to these factory Waveforms. Instead, you may start from scratch and design your own Waveforms. This happens in the Wave window.

The Wave window provides you with a selection of drawing tools and functions in order to create custom Waveforms according to your needs. By default, you see the Waveform page. To create a new Waveform, simply select one of the graphic tools in this view and draw the curves with the mouse. You can then apply various transform functions to the Waveform such as turning the curve on its head, changing its phase etc. You can also produce many weird and wonderful sounds using the Fractalize command. As well as changing the temporal progression of the Waveform, you can also edit its harmonic content using the tools in the Spectrum page. Just draw the amplitude and phase of the harmonics and you can produce subtle to drastic changes in the resulting Waveform.

When you are happy with a Waveform you created, you can store it in your own Waveform library. These Waveforms are then readily available in ABSYNTH 5 for any use. Another powerful feature is the possibility to morph different Waveforms: the resulting Morph Wave will be “somewhere” between two fixed Waveforms. This way, you can produce interesting curve progressions, which allow greater variety in the creation of Sounds and control signals.

The Quick Start at section 4.4, “Creating and Morphing Waveforms”, will give you a practical illustration of how to use Waveforms.
3.1.5 The Mutator

The Mutator proposes a totally different approach to the generation of new Sounds. Let’s say, you found a nice Sound in the ABSYNTH 5 Library, but you would like to have some of its characteristics tend towards those of another nice Sound from the Library, or even of a selection of Sounds. The Mutator allows you to select some parts of the Sound currently loaded and to “mutate” them towards the equivalent parts of other Sounds. These other Sounds are selected via the Browser (the big organizer for both factory and user-defined Sounds). The mutation is made based on “feeling”:
- You can set the extent of the mutation (how far from the original Sound).
- You can add some randomization to the mutation of all affected parameters.

The result is a new full-featured Sound – and you got it in one click! Furthermore, you can iterate the process as many times as you want, recursively mutating your Sound, going back to some previous Sound Mutation and trying another direction, thereby traveling through endless Sound space. In addition, the Mutator provides you with eight intuitive Finetuning controls allowing you to custom shape some global characteristics of the newly generated Sounds, or any loadable Sound as well!

To use the Mutator you hardly even need to know the internal structure of your Sound. Instead, think of subjective descriptions of the Sounds – in NI terminology, we call them “Attributes”, the Mutator will learn from the patches with those characteristics. In order to use the Mutator, the only thing you need to do is choose some other Sounds from the Library. Therefore, the Mutator and its creations are directly integrated with the Browser window, but can be triggered from anywhere in ABSYNTH 5.

You will find a practical example of mutating Sounds at section 4.2, “Mutate Your Sounds!.”

3.2 The User Interface

In this section, we will introduce you to the individual windows, areas and control elements of ABSYNTH 5 so that you get to know its user interface. For an in-depth explanation of each window and all its functionality, please refer to the Reference Manual.
3.2.1 Navigation Bar

The Navigation Bar is a central feature in ABSYNTH 5. Located at the top of ABSYNTH 5’s user interface, it is the only area that is always visible.

1. ABSYNTH logo
2. Browser tab
3. Attributes tab
4. Perform tab
5. Wave tab
6. Patch tab
7. Envelope tab
8. Effect tab
9. LFO tab
10. Record button
11. CPU meter
12. Input Level meter
13. Output Level meter
14. Panic button
15. NI logo
16. File menu
17. Edit menu
18. Sound Name display
19. Previous Sound button
20. Next Sound button
21. Mutate button
22. Retry button
23. Save button
24. Save As button
25. Database Activity indicator
26. Keyboard button
### 3.2.2 Browser Window

1. Browser Control Bar
2. Sounds button
3. Instruments button
4. Effects button
5. Search Field
6. Reset button
7. On button
8. Programs button
9. Load button
10. Save button
11. Categories
12. Attributes
13. Search Result List
3.2.3 Attributes Window

1 Instruments button
2 Effects button
3 Reset button
4 Categories
5 Attributes
6 Meta Information
3.2.4 Perform Window

1 Global Settings Bar
2 Master Envelope area
3 Audio In area
4 Virtual Keyboard
3.2.5 Patch Window

1. Channel A
2. Channel B
3. Channel C
4. Master Channel
5. Channel A Pan control
6. Channel A Level control
7. Empty Module Slot
8. Waveshaper module
9. Modulator module
10. Filter module
11. Oscillator module
12. Edit menu
13. Main tab
14. Mod tab
15. Uni tab
16. Anti Alias Switch
17. Frequency menu
18. Synthesis menu
19. Waveform Selector
20. Main tab
3.2.6 Effect Window

1 Effect Switch
2 Effect Selector
3 Input Mixer
4 Input Lowpass control
5 Input Highpass control
6 Output Mixer
7 Wet Level control
8 Dry Level control
9 Surround Panner
10 Control area
11 Macro Control Select menu
12 Depth control
13 Lag control
14 Master section
3.2.7 Wave Window

1 Wave List
2 Wave Usage List
3 Waveform tab
4 Spectrum tab
5 Morph tab
6 Morph Wave Selector
7 Draw Mode Tools
8 Transform menu
9 Edit Anchor
10 Wave display
11 Amplification control
12 Offset control
3.2.8 Envelope Window

1 Envelope List
2 Envelope area
3 LFO area
4 Control area
5 Envelope display
6 Breakpoint Handle
7 Breakpoint Slope Handle
8 Zoom Handle
9 Grid Switch
10 Lock/Slide Switch
11 Transform menu
12 Retrigger Beat control
13 Master Envelope area
3.2.9 LFO Window

1. Oscillator section
2. Channel Parameter section
3. Master Parameter section
4. Controller section
4 Quick Starts

This chapter introduces you to the basic operations with ABSYNTH 5. Using practical examples, it will guide you through common tasks and workflows, letting you progressively discover some of the important features of this powerful synthesizer. You will learn how to find and load a Sound from the ABSYNTH Library and how to quickly create new Sounds from existing ones using one of the new features introduced in ABSYNTH 5: the Mutator. You will be introduced to the more classical, “analytic” sound design: filling your patch structure with modules, configuring them, and adding some modulation, thus building a Sound from scratch.” You will be able to produce your own Waveforms and to utilize the Wave Morph feature. Finally, the last Quick Start illustrates how to use ABSYNTH 5’s powerful effect unit with the example of the new Aetherizer.

We assume in this chapter that ABSYNTH 5 is already installed and correctly set up on your computer. If it is not the case, please start off with the instructions given at chapter 2, “Setup”, and come back here when ABSYNTH 5 is ready!

⚠️ For all these Quick Starts, we will use ABSYNTH 5 in stand-alone mode. Unless otherwise stated, the instructions apply for the plug-in version as well.

At first, start the ABSYNTH 5 stand-alone application on your computer:
► On Windows, select Start > Programs > Native Instruments > Absynth 5 > Absynth 5.
► On Mac OS X, open Macintosh HD > Applications > Native Instruments > Absynth 5 and double-click on the ABSYNTH 5 application icon.

Once ABSYNTH 5 is running, you are ready to proceed with the Quick Starts!

4.1 Finding and Loading Sounds

In this Quick Start, you will learn how to find and load a Sound from the ABSYNTH 5 Library via the Browser in order to play the Sound from your MIDI keyboard.
4.1.1 The Plan

As an example, we will search for a sound for a film. We have a piano unlike any other in mind, a piano that is accompanied by mysterious, floating sounds. The ideal sound would be evolving even after the note was played, in order to create a strange atmosphere. Also, we want the sound to use the surround capabilities of ABSYNTH 5. We are working on film music and must operate using multi-channel film score formats. We could now search the entire ABSYNTH 5 Library for the right Sound and listen to each and every one. But thinking that the ABSYNTH 5 Library contains more than 1700 Sounds, that would be quite tedious, and we may have forgotten our musical idea way before we actually find anything fitting. This is where the Browser comes into play.

4.1.2 The Browser

The Browser and the so-called Attributes will help us to rapidly track down the right Sound. The Browser offers an environment in which you can search for Sounds quite intuitively. You do not have to recall abstract things like preset names or even numbers. In fact, you can just select terms that describe the desired sound from a list, and they will be used as search criteria. These descriptive terms are called Attributes in ABSYNTH 5. The sound designers at Native Instruments have already defined Attributes and Meta Information for all Sounds from the ABSYNTH 5 Library, so your search can begin immediately. Normally, ABSYNTH 5 shows the Browser window directly after starting up. If another window is currently displayed, you must call it up yourself. To do this:

► At the top of ABSYNTH 5’s window, in the so-called Navigation Bar, click on the Browser tab, which you find on the left side:

![Browser tab](image)

Click on the Browser tab.

→ The Browser tab gets highlighted and the Browser window opens underneath the Navigation Bar.

You can see that the Browser window is divided into several areas:

- The five columns on the left make up one group called the Database view. The headings are the category names, below are all the Attributes. To select an Attribute, click with your mouse on it. The selected Attributes are highlighted. To deselect an Attribute, click on it again.

- On the right, the Search Result List displays your search results. The list is divided into columns that contain information about the selected Sounds. Besides the Sounds' names, the Search Result List can display many more info on the
Sounds (more on this in the Reference Manual). You can also sort the results according to any column heading by clicking on the desired heading.

- At the bottom, you see the Mutation section, but we don’t need it for now. You will learn more on this in the next Quick Start, at section 4.2, “Mutate Your Sounds!”.

You can use your mouse scrollwheel to scroll the Search Result List. At the moment, the list is really huge... This is because we didn’t narrow our search yet—what you are seeing in the list is just the whole ABSYNTH 5 Library!

### 4.1.3 Finding the Right Sound

Let us now start searching for our Sound by selecting the right Attributes. You will find the different types of synthesized sounds in the first column of the Database view, which is titled *Instrument*. This does not just include pure instruments but also sound effects and voices. We are looking for a kind of piano and therefore choose the Attribute *Piano/Keys* from the top of the list:

1. Click on the Attribute *Piano/Key*.

   → Take a look at the Search Result List: the list has become shorter because all the Sounds that are not tagged the Attribute Piano/Keys have disappeared from the list.

You can specify the basic character of a sound in the next column titled *Source*. Here you will find entries that describe certain synthesis techniques, for example *FM* or *Physical Model*, but also general Attributes like *Processed*, *Layered* and *Surround*. We will select the last three mentioned:

1. Click on the Attributes *Processed*, *Layered* and *Surround*.

   → You will see a shorter list of Sounds in the Search Result List.

We continue by selecting some other Attributes in the following columns/categories:

1. In the column *Timbre*, select *Soft* and *Noisy*.
1. In the column *Articulation*, click on *Decaying*, *Long Release* and *Long/Evolving* and to be safe also *Sweep/Filter Mod*.
1. In the last column *Genre*, click on *Film Music*.

Now look at the Search Result List. ABSYNTH 5 only offers you a single Sound, namely the one that contains all the chosen Attributes: “Spirit Rain.”

1. Double-click on this entry in the Search Result List.

   → The Sound is loaded.
Now you can play this Sound from your MIDI keyboard. You do not necessarily need to set all of the Attributes named here to get to this type of sound. From time to time, you will see that fewer Attributes will lead to good results. This also applies to situations where ABSYNTH 5 does not deliver any hits at all. In such cases, you can expand the search spectrum by deselecting some of the Attributes until usable results are shown.

4.1.4 Using the Search Field

The Browser provides you with another tool to find the desired Sounds: the Search Field. Located at the top of the Browser window, in the so-called Browser Control Bar, it allows you to run a text search within your Library, including the content of your Sounds’ Meta Information. This tool can be used together with the selection of Attributes explained above.

The Search Field.

1. Click in the Search Field.
2. Enter any term with your computer keyboard.
   → The Search Result List displays only the Sounds containing this term, may it be in their name, in their Attributes or somewhere in their Meta Information.

4.1.5 Always available

Your current Search Result List is always mirrored in the Sound menu, called by clicking on the Sound Name display, in the middle of the Navigation Bar:

The Sound Name display.

► Click on this Sound Name display.
   → The Sound menu opens and displays the content of the Search Result List. This is very handy to quickly switch to another Sound from anywhere in ABSYNTH 5.
4.2 Mutate Your Sounds!

What if the Sound that you found in the Library is not exactly the one you were looking for? For sure, you could dive into the Sound’s structure and try to understand all its details and then deduce where to cut in. But most of the Sounds to be found in the ABSYNTH 5 Library have a quite complex structure—our sound designers have spent a lot of energy in shaping them precisely. Therefore, it might take some time to understand how they work, and you would need some patience (nevertheless, it is a very good way to learn!). Moreover, you would risk forgetting in the meanwhile the idea you had in mind.

ABSYNTH 5 introduces a totally new approach for sound crafting, using exclusively the Browser and its Attributes. As explained in the section 3.1.5, “The Mutator”, above, the idea is to select other Sounds in the Browser and to mutate the currently loaded Sound “somewhere” in their direction. As you will see, the procedure is terribly simple and intuitive, and you can get close to your original idea within a few seconds, or even discover new sonic possibilities you had not imagined before.

As we will use here the Browser window, we recommend you to first read the previous Quick Start in order to get familiar with its basic principles (Attributes, Search Result List, etc.).

4.2.1 Choosing the Right Direction

We suppose that you have your Sound loaded (for example the Sound “Spirit Rain” that we found in the previous Quick Start):

The Sound Name display in the Navigation Bar.
We first need to describe, in terms of Attributes, what kind of characteristics we would like to inherit from other Sounds. For example, we could wish our Sound “Spirit Rain” to have a slight darker feeling and to present some kind of random character:

1. If not done already, open the Browser window by clicking on the Browser tab in the Navigation Bar.
2. Select the Attribute *Dark* in the category Timbre and the Attribute *Randomized* in the category Articulation.

By the way, you notice how the Search Result List gets shorter upon each Attribute selection. This Search Result List will be used by the Mutator as the pool of Sounds from which the characteristics will be inherited. The two Attributes that we just selected already generate a reasonably short Search Result List, let us use it now to mutate our Sound.

If there are some characteristics in your current Sound that you definitely want to keep, it might be a good idea to select their corresponding Attributes in the Browser in order to ensure that these characteristics will also be there in the Sounds from the Search Result List then used for the mutations.

### 4.2.2 Two Sliders, Two Buttons

Let us move to the bottom of the Browser window, where we find the Mutation section:

![Mutation section](image)

The Mutation section.

In the top part of this section, right in the middle, we find two sliders and two buttons. They will be the only controls we need for now.

The Mutation Amount slider defines the extent of the mutation towards the characteristics of the Sounds in the Search Result List: the more the Mutation Amount is, the further the mutated Sound will be from the original Sound.

The Randomization Amount slider defines the amount of randomization applied to the resulting patch, resulting in infinite possible mutations for each Sound.

1. Click on the Mutation Amount slider, hold the mouse button depressed and drag the slider until a value around 25 % of its range.
2. In the same way, set the Randomization Amount slider to zero (fully left).
3. Click on the Mutation button, to the right of the Mutation Amount slider.
When you play the Sound, you hear that it is very similar to the original one, but with slight changes though. If the changes are too small for you, feel free to mutate again:

► Click again on the Mutation button.

→ The name of the Sound loaded is now followed by the mention \textit{M 2} (for “Mutation 2”), and the name appearing in the Mutation History is updated too.

If you don’t like the overall sound of this last mutation, you can use the Retry button instead of the Mutation button.

► Click on the Retry button.

→ The new mutation replaces the current one. You can see that the Sound name stays the same.

Play a bit with these four controls to get familiar with the basics of the the Mutator. You can raise for example the Mutation Amount to move further away from the original Sound. Or you can set the Mutation Amount to zero and significantly raise the Randomization Amount slider: your Sound will only randomize.

### 4.2.3 Refining Your Mutation

The Sound Mutation section provides you with two additional tools that allow you to better adjust the resulting mutations.

**The Mini-Patch View**

The Mini-Patch view.
The Mini-Patch view represents the whole patch of your Sound, as it appears in the Patch window. Here you can select which modules of your Sound you want to mutate:

- The Module Slots that are not used in your current patch are dimmed:

- The Module Slots currently disabled for mutation have only their borders highlighted:

- The Module Slots currently enabled for mutation are fully highlighted:

You even have buttons for the Envelopes and LFOs of your Sound, so that you can decide to include them or not in the mutation process.

To enable/disable a particular module for mutation, click on its icon in this Mini-Patch view.

Using the Mini-Patch view can be a great help to get results related to some particular Attributes. For example, if you select a “Bass” Sound but then want it to be more “Percussive” then make sure to activate the Envelope button in the Mini-Patch view, and maybe the Effect module. If you want an “FM” sound, select the Oscillators and nothing else.

The Finetuning Controls

At the bottom of the Mutator section, you see a row of eight controls. These are the Finetuning controls:

The Finetuning controls form a quick access to eight characteristics of each particular Sound. These controls allow to quickly tweak the Sound after a Mutation or after loading.

Only parameters used in the current patch are active. The other ones are dimmed.

These Finetuning controls are intended to make on-the-fly adjustments to your Sounds when browsing or mutating them. They are not meant for live performance for example, therefore they cannot be automated, modulated nor controlled via MIDI!
4.2.4 Using the History

While mutating your Sounds, you can use another tool to avoid getting lost in all your experiments: the Mutation History.

The Mutation History section.

Sitting in the right part of the Mutator section, the Mutation History shows you the name (and thus the number) of the Mutation currently loaded, along with two arrow buttons: these allow you to switch to the previous/next Sound Mutation, if any. When you click anywhere else in the area, the Mutation History dialog opens. This dialog keeps track of all your mutations so that you can quickly audition anything you have done by simply selecting it. This allows you to compare various Sound Mutations and also to save your favorites as fully-fledged Sound for later use, via the Save As button.

4.2.5 Tips

Here are a few more tips that might help you to get familiar with the settings for the Mutator:

• If you set the Mutation Amount slider at a higher value, you will actually get more predictable results. This is because as the slider gets higher, the Mutator algorithm is more likely to load a whole Channel for a patch, which means that the Envelope, Filter and Oscillator will have been crafted for each other; it also means that the patch is less “origiRolling the dice and doing a full Mutation on all modules in the Mini-Patch view often gives interesting results.

• The Retry button and Finetuning controls are especially useful when you want to stick with results only in the category you have in the Browser.

• A useful feature: Your Macro Control assignments stay mapped during the Mutations. Try making a patch with assigned Macro Controls for a type of Sound that you like to play live, then mutate. In most cases you still have the controls you want.
4.3 Creating Sounds: the Good Old Way

ABSYNTH 5 comes with an extensive selection of different Sounds. In the previous Quick Starts, you have learned how to load and play the Sounds from the existing Library and how to mutate them to give them some characteristics of other Sounds. But you can also create your own Sounds from scratch. This method has the following advantages:

- You know exactly what you are doing, and why.
- You know the role of every single part of your Sound, thus allowing you to shape your Sound very precisely.
- In addition, you will learn about the basic principles of audio synthesis!

This section teaches you how to build your own polyphonic lead sound. You will learn how to add and combine modules in the Patch window, how to adjust some of their parameters, and how to implement a parameter modulation with an Envelope.

4.3.1 Preparations

Start up the stand-alone version of ABSYNTH 5. Let us begin working on a new empty Sound:

1. Click on the the File menu, located at the far left in the upper Navigation Bar:

   ![The File menu.](image)

2. In the menu that opens, select *New Sound* to create a new empty Sound. You can also set up a new Sound by pressing the key combination `[Ctrl]+[N]` (Windows) or `[Cmd]+[N]` (Mac OS X).

As mentioned in the introductory section 3.1.1, “Semi-Modular Design”, the Patch window is used for creating the foundation for any Sound within the semi-modular design of ABSYNTH 5. Let us show this Patch window:

- In the same Navigation Bar, click on the Patch tab:

   ![We just clicked on the Patch tab.](image)

   → The Patch window is now displayed underneath the Navigation Bar:
At least one Oscillator module must be active for ABSYNTH 5 to produce an audio signal. As you can see on the picture above, the Oscillator module in Channel A should be already activated when you call up an empty Sound, with its Waveform set to Sine. All the other Module Slots are free (remember: Module Slots are the framed areas in the Patch window in which you can put the modules). This means that, for now, the remaining Module Slots are not active.

You should now be able to play this Oscillator module: when you press a key on your MIDI keyboard, the sine wave produces a sound corresponding to the frequency of the note played.

If no MIDI keyboard or controller is available in your setup at the moment, you can use your computer keyboard (QWERT) instead, or the Virtual Keyboard, which is available in every window. To activate the Virtual Keyboard, click on the little keyboard icon on the top right corner of ABSYNTH 5’s window (below the NI logo). It appears at the bottom of the window, and you can play your instrument by clicking on the keys.
4.3.2 Configuring the First Module

The sound of a dry sine wave is not very powerful indeed. We want to have a stronger lead sound. For that, we will first change the Waveform used in that Oscillator A (for more info on the concept of Waveform, please read the section “Waveforms”). To do this:

► Click on the Waveform Selector in the Oscillator A, next to the small waveform diagram:

The Waveform Selector of our first Oscillator, currently displaying Sine (the loaded Waveform).

→ A Waveform Selection dialog (labelled Select or Create a Wave) opens containing a list of all available Waveforms.

You will notice that, when selecting another Waveform in the list, the little waveform representation changes accordingly, both in the dialog and in the Oscillator module. You can play the selected Waveform immediately through your MIDI keyboard (or computer keyboard, or Virtual Keyboard), thus allowing you to hear whether the resulting sound meets your expectations or not. This way, you can quickly find a Waveform that fits your needs.

The Waveform Square_real seems to be good for our lead sound. You can already hear how sharp and assertive this Waveform sounds. Therefore, it will easily makes a strong lead sound which will not get lost, even in a dense mix. So let us take it:

1. Select the Waveform Square_real in the Waveform Selection dialog.
2. Click “OK” at the bottom of the dialog.

→ The dialog is closed and the Waveform Square_real is now sitting in your Oscillator A.
4.3.3 Adding other Modules

Adding a Second Oscillator
We will now add another Oscillator to give the sound more character. To do this:

► On the right side of our Oscillator A, click on the thick left border of the dimmed Module Slot B displaying Osc B.

→ The Module Slot B gets activated and shows the default Oscillator module with a Sine wave loaded. We now have our two Oscillators A and B side by side.

Again, we do not want to keep the default sine wave in the newly activated module:

► Replace the current Waveform Sine of the Oscillator B with the Waveform Saw_filt2 by repeating the steps described above for the Oscillator A.

We recommend you to listen repeatedly to the sound after each step, in order to get a feeling of its influence. At any moment, you can deactivate any module and reactivate it by clicking on its thick left border, in order to compare the sound with and without this module—don’t worry: when you reactivate it, ABSYNTH 5 remembers your last settings.

Adjusting the Transposition
We will now transpose the Oscillator B by one octave, in order to better separate its sound from the first one. You can see the Frequency control (showing 0.0000 at the moment) right under the Waveform Selector that we used a few seconds ago:

The Frequency control, right under the Waveform Selector (here in the Oscillator B). This parameter defines the offset of the Oscillator’s pitch against the pitch of the note that you play on the keyboard—in short, its transposition.

The behavior of the Frequency control actually depends on the setting in the left-hand Frequency menu—for now set to Trans. It is not always a transposition. For more info, please refer to the Reference manual.

1. Click on the left-hand diamond sitting to the right of the Frequency control, hold the mouse button depressed, drag your mouse up until the display shows 12.0000 (12 semitones, which make one octave) and release the mouse button. Now your Oscillator B plays one octave higher than the Oscillator A.

2. Adjust further the Frequency control to 12.1100 using its middle diamond.

→ The small detuning produces a subtle beat in your sound—this often makes leads and pads sound livelier and stronger.
Adding a Filter

We will now process the sound with a filter in order to reduce a bit the high frequencies. For this, we require a Filter module. We want it to process both Channels A and B, so we will put it on the Master Channel, at the bottom of the Patch window:

► Activate the Filter module by clicking on the thick left border of the Module Slot labelled Filter, in the Master Channel.

You recognize the signal flow in your Sound by the wires that connect the three active modules. The signals coming from both Oscillators are combined in the Master Channel and run through the Filter.

We would like to use a low-pass filter with a gentle frequency slope that cuts frequencies starting from 5000 Hz. To do this:

1. In the Filter module, click on the Type menu (labelled Type). In the menu that opens, select the entry LPF 2 Pole.
2. Beneath the Type menu, set the Frequency control to approximately 5000 Hz via the little diamonds.

You will notice that with this Filter setting, the sound is less aggressive in the high frequencies and gets a warmer feeling.

We might quickly adjust further the Filter settings by doing the following:

1. Set the Resonance control (labelled Res, beneath the Frequency control) to about 0.3 so that the sound gets a bit more presence.
2. Slightly raise the lower Damping control (labelled dB) to compensate for the level attenuation due to the filter. A value around 2.5 dB seems to do the job.

Here is how your new Filter should look like:

We now have a nice filtered sound!

Getting Dirty: Using the Filter Feedback

ABSYNTH 5 introduces a new powerful functionality to some of its Filter modules: a feedback loop. This feedback loop allows you to send a portion of the filter’s output back to its own input... without forgetting to further process the signal on the way! The feedback is available for following filter types: LPF 2 Pole, LPF 4 Pole, LPF 8 Pole, Supercomb, Allpass 2, Allpass 4 and Allpass 8.
Until now, all filter’s parameters that we adjusted were located on the Main panel. To access the feedback loop settings, you need to switch to the dedicated panel. To do this:
► Click on the tab labelled *FB* at the top of the module:

![FB tab](image)

→ The Feedback panel replaces the Main panel in the module area.

By default, the feedback is deactivated: the Feedback Mode menu (for now the only menu that you see) shows *Normal*. We will not give here all the details about the various feedback possibilities (for that, the Reference Manual is waiting for you), but we will just show you how you can quickly give a slightly dirty touch to your Sound. For that, we use a feedback based on ring modulation:
1. Click on this Feedback Mode menu.
2. Select *Ringmod* in the menu.
   → The Feedback panel displays the settings for that particular feedback mode:

![Feedback panel](image)

Do not hesitate to play a bit with the settings in this Feedback panel: you can get very interesting results!

We propose you to set the feedback as follows:
1. Click on the Waveform Selector (right below the Feedback Mode menu), select the Waveform *Square_fractal* and click “OK” to confirm and close the Waveform Selection dialog.
2. Under the Waveform Selector, set the feedback’s Frequency control value to something around 750 Hz.

Now your Sound has a distinct noisy component whose tonal content changes with the note played. Use the Mix control at the bottom to adjust the amount of feedback that you want to apply.
The applications of the feedback loop are endless. They also depend on the audio material sent to the filter. Don’t hesitate to try different settings in various situations! For more info, please refer to the Reference Manual.
4.3.4 Interlude: Saving Your Sound

It is highly recommended to save your work regularly, in order to avoid any accident. Hence, we propose you to do it now before to go deeper in the sound design. To save your Sound in the KORE SOUND format (*.ksd), do the following:
1. Click on the Save As button in the Navigation Bar. A Save As dialog will open up.
2. Select the folder in your file system where you want to save your Sound. By default, ABSYNTH 5 proposes you the “My Sounds” folder. Enter a name for the KORE SOUND file, for example: “My Lead Sound”, and click on “Save.”
→ Your Sound is now saved.

⚠️ We recommend that you save the Sound in the default folder proposed by ABSYNTH 5 or in one of its subfolders. This will automatically integrate the Sound into the ABSYNTH 5 Database and make it readily available in the Browser window in the same way as the Sounds provided in the Factory Library.

4.3.5 Modulating the Filter

We can now continue to shape our Sound. To make the sound more interesting, we can for example modulate the Filter’s frequency. The term “modulate” means the automated change of a parameter via some control signal. To do this, we need to set up a modulation source (the control signal) and a modulation target.

⚠️ For a presentation of the concept of modulation, please refer to the section 3.1.2 “Modulation” above.

In our case, the modulation target is the Frequency control of the Filter module that we implemented in the previous section. To modulate this parameter, we will use an Envelope as modulation source.

What Envelopes Do
► Open the Envelope window by clicking on the Envelope tab in the Navigation Bar:

→ The Envelope window replaces the Patch window in ABSYNTH 5’s interface.
By default, three Envelopes are already set up for new Sounds: they control the signal amplitude for each Oscillator A, B and C. These Envelopes are listed in the bottom left part of the Envelope window, in the so-called Envelope List (labelled Available Envelopes). In this list you find, for example, the amplitude Envelopes of our two Oscillators: Oscil A Amp and Oscil B Amp.

All the selected Envelopes in the Envelope List are depicted in the main part of the Envelope window, one on top of the other, in the so-called Envelope display. In the Envelope display, each Envelope essentially is a assembly of segments and curves of various colors and directions, joined by a few points between them.

Now the basic thing to know is: These segments indicate the level of the modulated parameter as a function of the time. The parameter levels are represented vertically and the time horizontally. The Envelope’s outlined course represent the value of the modulated parameter: when you play a sound, this course is triggered and the fluctuating value of the Envelope controls the value of the target parameter.

Creating a New Envelope for the Filter Frequency
We actually want to work on the Filter’s Frequency. First we must create this Envelope, as it does not appear in the list yet:

1. In the Envelope List on the left, click on the New Envelope button.
   → The so-called New Envelope dialog opens.
On the left, you see a list of the activated modules in your patch, along with the whole Channels in use. According to your selection in this left column, the middle column then displays the list of parameters that can be modulated.

1. In the left column, select *Filter Master 2*.
2. In the middle column, select *Filter Master 2 Freq.*

   → The newly added Envelope now appears in the Envelope List and it is already selected, thus showing up in the Envelope display.

If not already done, and if you feel more comfortable, you can hide all other Envelopes from the Envelope display. For example, you can do this as follows:

► Choose the entry *All Filter* from the Show menu at the top of the Envelope List.

In other situations, keeping several Envelopes displayed on the Envelope display can be very handy to synchronize the evolution of several parameters!

We are now ready to draw the Envelope for the Frequency control of our Filter.

**The Breakpoints**

The points joining the various segments of your Envelope are marked with small squares. These squares represent the Breakpoints. You can work on the Breakpoints as you see fit: add new Breakpoints to the Envelope, delete Breakpoints, or relocate them—this is all we need here.

For now, the Envelope is a straight line that sticks at the top of the display. In other words, the Filter’s Frequency stays at its maximum value as long as we play the note (this maximum value being defined by the Frequency control, see chapter 4.3.3, “Adding other Modules”).

We would like our Filter to close shortly after hitting a note, and then open again. For that, we need just need to move one Breakpoint. To do this:

1. Click on the second small square (labeled “A”) and hold the mouse button, drag your mouse down until the Frequency control within the Selected Breakpoint area displays something around 500 Hz.
2. If you want the modulation to be faster, you can drag the Breakpoint to the left.
When playing your Sound, you will notice that the filter closes for a brief moment after the note is struck, then opens again: the sound very quickly becomes duller and less stellar; moreover, the modulation makes it livelier and more diverse. Feel free to move around more Breakpoints to learn how they influence your Sound.

We Envelope window holds many more tools to shape your Envelopes! This was only an introduction to this huge topic: Envelope can indeed dramatically alter the properties of your Sound. You will find a thorough description of all available functions and controls of the Envelope window in the Reference Manual.

Our lead sound has now been completed, it is high time to give it a few Attributes!

### 4.3.6 Add Attributes to Your Sound!

In the first Quick Start, we pointed out the big role played by Attributes in finding Sounds quickly and easily via the Browser (see section 4.1, “Finding and Loading Sounds”). In order to make the most out of this powerful tool, we highly recommend you to tag your Sounds right away with the appropriate Attributes. Thereby, before to load any other Sound, do the following:

1. Click on the Attributes tab in the Navigation Bar. The Attributes window opens.
2. In the left part of the Attributes window, select the Attributes that describe your Sound at best. You can select several Attributes in the same category (with the exception of the category Instrument at the far left).

3. In the right part of the window, enter the desired Meta Information. The Comment Field allows you to store any information you want; for example, this can be the name of the project in which you want to use this Sound.

4. Click on Save in the Navigation Bar.
   → Et voilà! Next time, you will find your Sound within a few clicks.

4.3.7 Useful Tips

We would like to show you here two very useful tips when building your own Sounds:

Using the Edit Menu
At the top left corner of every module, you find a very handy tool: the Edit menu.
   ► Click on the Edit menu in any module.

In this menu, you find a bunch of useful commands:
• You can copy your module to the clipboard and paste it (with or without its Envelopes) in another Module Slot—if it is an Oscillator module, you can even copy/paste the entire Channel to another Channel.
• You can store frequently used combinations in your Template Library to load them later (in the same Sound or in another one).
• You can apply the Mutator specifically to this module! (For more info on the Mutator, see the previous Quick Start at section 4.2 “Mutate Your Sounds!”).

These tools can dramatically accelerate your work when building complex Sounds. You will find all details on these tools in the Reference Manual.

Opening Several Windows
After a while adjusting a complex Sound, you might find it annoying to switch all the time back and forth between the various windows. In the stand-alone version of ABSYNTH 5, there is a solution for this:
   ► Hold [Ctrl] (Windows) or [Cmd] (Mac) on your computer keyboard while clicking on one of the following tabs in the Navigation Bar: Patch, Effect, Wave, Envelope or LFO.

The corresponding window does not replace the previous window but opens in a new pop-up window Depending on the size of your computer screen, you can display two or more windows, place them where you want on your screen and work simultaneously on different parts of your Sound, both giving you a better overview of various ABSYNTH 5 components and speeding up your workflow!
This works in the stand-alone version only, not in the plug-in version!

4.3.8 What Is Next?

Of course, this quick introduction merely gives you a brief insight into the sound synthesis in ABSYNTH 5. Continue your own research by drawing your inspiration from the instructions detailed above. For example, you could:

- Use an additional Oscillator to generate a sonic background and make the sound even livelier.
- Add more Filters and Envelopes.
- Implement a modulation via one or several LFOs.
- Apply one of the impressive ABSYNTH 5 Effects on the Master Channel.
- Etc.

Don’t hesitate to look inside Sounds from the ABSYNTH 5 Library, you will find enlightening examples of what can be done—the fact is: the possibilities are almost endless.

4.4 Creating and Morphing Waveforms

In this section you will learn how to merge Waveforms into a Morph Wave, with the help of the function Wave Morph. This function allows you to morph back and forth between Waveforms—between a sine wave and saw tooth wave, for instance.

4.4.1 Creating a Morph Wave

1. Create a new empty Sound (for more info in this, please look at the previous Quick Start, especially the section 4.3.1 “Preparations”).
2. In the Patch window, click on the Waveform Selector of the only active Oscillator (the area to the right of the little waveform picture displaying Sine for now). The Waveform Selection dialog opens with the list of all available Waveforms.
3. In the upper part of this dialog, click on the category Morph Waves and choose the entry Miss Morphy from the list below.
4. Click on the New Wave button to load a copy of the selected Morph Wave.
   → ABSYNTH 5 immediately switches from the Patch window to the Wave window, holding the newly loaded Morph Wave.
The Wave window with the Morph Wave “Miss Morphy” loaded.

**The Wave List**

On the left side of the window, the Wave List (labeled *Editable Waveforms*) shows you all editable Waveforms that you already created via the New Wave button. Currently, our Waveform is the only one there (unless you already worked with Waveforms before). It is a good idea to name your Waveform right away. To do this:

► Click on the name of the Waveform. The current name is highlighted and an insertion mark invites you to enter a new name via your computer keyboard. Confirm the new name by pressing [Enter] on your computer keyboard.

The Wave List showing our only Waveform with its new name.

Below the Wave List, you find a second list called Wave Usage List. This list shows you all places within your patch which use the Waveform currently selected in the Wave List above. Right now, there is only one entry in the list: *Oscil Main A*, which means “Main Waveform of the Oscillator A”–this is where we clicked on the Waveform Selector. This feature can become very handy to gain an overview of which Waveform you are working on, in the case of multi-layered Sounds using the same Waveforms in many places.
4.4.2 Editing the Initial Waveforms

We now have this Morph Wave loaded. Like any Morph Wave, it is the combination of two Waveforms. At the top of the Wave window, you see three big tabs labelled Waveform, Spectrum and Morph. They open the Waveform page, Spectrum page and Morph page, respectively:

The Waveform, Spectrum and Morph tabs, along with the Morph Wave Selector. When the Waveform page or Spectrum page is active, you see a pair of buttons to the right of the three tabs, both showing a little stylized waveform followed by 1 or 2: this is the Morph Wave Selector. The Morph Wave Selector allows you to select which of the initial Waveforms you want to display for editing.

Let us start working on the first of the two Waveforms.

Editing the First Waveform

We first erase the current Waveform:
1. Click on the Waveform tab to activate the Waveform page (if it is not activated).
2. Check that the first Waveform is selected in the Morph Wave Selector:

   If it is not the case, click on its first button labelled 1 to select it.

3. Click on the Transform menu above the Wave display:

4. In the menu that opens, select the last entry: Clear.
   → The Waveform that was displayed is now replaced by an horizontal line in the middle (zero).

Don’t worry: you did not erase anything from the Factory Library! Remember that we work on a copy of the original Morph Wave...
We can now create a brand new Waveform instead. Note the vertical line going through the Wave display and ending with a small handle at its top. This is the Edit Anchor. It defines a point on the Waveform which stays fixed during your editing. Here is how it works:

1. Click on the Edit Anchor’s handle, hold your mouse and drag it fully to the left. This will mean that the left end of the Waveform is momentarily fixed.
2. Select the Line Draw Tool to the left of the Transform menu:

3. Click somewhere on the Wave display, hold the mouse button depressed and drag your mouse to the top right corner of the display. In the meanwhile, you see the line being drawn between the fixed point on the left (defined by the Edit Anchor) and the mouse position. Release the mouse button. The Edit Anchor automatically jumps to your mouse position. This defines the new fixed point for your next editing.
4. In the same way, click somewhere on the display again, drag your mouse to the bottom left corner and release the mouse button.
   → You now have a nice line from the bottom left corner to the top right—a beautiful saw tooth!

**Editing the Second Waveform**

To switch to the second Waveform:

► Click on the button labelled 2 of the Morph Wave Selector:

For this Waveform, we want to use a sine wave. Instead of drawing a sine by hand, there is an easier way: we simply load the sine wave from the Waveform Library provided. To do this:

1. Select the entry Load… in the Transform menu. This opens the now well-known Waveform Selection dialog.
2. Choose the category Simple Waves—only a single sinus wave is needed, not a Morph Wave, choose the entry Sine from the list and confirm your selection with a click on “OK.”
   → The Waveform Selection dialog closes and the sinus-curve is loaded.

We cannot go into every possibility for working on loaded waves in this quick introduction. For example, we have not yet looked at the functions available in the Spectrum page. But you will find information on all the tools and functions in the Wave window in the Reference Manual.
4.4.3 Playing with the Morphing

Until here, we have created two independent Waveforms. Now we will bring these two Waveforms together.

► Click on the Morph tab to switch the Wave window to the Morph page.

Here you can see the two individual Waveforms *Wave 1* and *Wave 2* in both upper displays. Right down at the bottom you see the Waveform *Morph Wave*—the result of the morphing, which is used in the actual sound generation.

You should always keep playing some notes on your MIDI keyboard while you change the desired parameters during this process. That way you can always hear immediately how the changes you make affect the sound.

You can modify two parameters in the Morph page: the mix between both Waveforms and the curves of the single waves. The latter ensures that the Wave Morphing is different than a simple cross fade. You can change the curve of the Waveforms via the Edit Anchors, which are represented in the Waveform display by vertical lines with handles at the upper end (like the Edit Anchor mentioned above).

When you first call upon a Morph Wave, there are two active Edit Anchors. But for our example, we will raise the number of Edit Anchors to three and spread them over the length of the Waveform:

1. In the Edit Anchors menu located in the upper left corner of the Morph page, choose the entry 3.
2. Drag (with the mouse button held down) the handles marked with letters, so that the Edit Anchors A are at full left, the Edit Anchors B in the middle of the displays and the Edit Anchors C at full right.

Now we turn to the Transition control, which is located at the top, to the right of the Edit Anchors menu:

The Transition control.
To understand how this control works, set it to different values while looking at the Wave display:

1. Click on first diamond next to the Transition control, hold the mouse button and drag your mouse vertically so that the control reaches the value 50. Each Waveform influences 50 percent of the Morph Wave, which results in a sinus-curve that climbs slightly like a rising saw tooth.

2. Reduce the value now to 0: What remains is solely the saw tooth from the first initial Waveform.

3. Raise the value to 100: You can see a splitting image of the second initial Waveform.

By positioning the Edit Anchors at different places in both initial Waveforms, you can get very interesting results in the Morph Wave!

### 4.4.4 What Is Next?

There are many things that you can try with the Morph Waves:

- It can get very exciting if you control them via a modulation source (LFO, Envelope) or via MIDI (with the Macro Controls).
- In the other direction, why not use a Morph Wave as Waveform within one of your LFO controlling other parameters in your Sound?
- Etc.

The Reference Manual gives you a thorough explanation of all details to be found in the Wave window.

### 4.5 Introducing the Aetherizer

In this last Quick Start, we would like to quickly introduce you to an impressive new Effect of ABSYNTH 5: the Aetherizer. This Effect can indeed affect your Sound in incredible ways. This will be the opportunity for us to show you how to use a Master Effect in your Sounds.

We will use here the Sound “My Lead Sound” that we created in the third Quick Start (please read the section 4.3, “Creating Sounds: the Good Old Way”, to make up for it). But of course, you can use any other Sound.
4.5.1 Get ready

First of all, we open the Sound “My Lead Sound”. If you have set Attributes to the Sound “My Lead Sound” before to close it, as we recommended, you will quickly find it by selecting these Attributes in the Database view of the Browser window, as described in the first Quick Start (see section 4.1, “Finding and Loading Sounds”). But if you have not created numerous Sounds yet, there might be another (maybe quicker) way to find this Sound again:

1. Open the Browser window.
2. Click on the Sounds button to switch from Database view to File Tree view:

3. In the File Tree displayed on the left side of the Browser, select the folder My Sounds. On the right side, you see all the Sounds that you already created (provided that you saved them to your “My Sounds” folder). You should quickly find the Sound “My Lead Sound” in the list. Double-click on its entry to load it. Your Sound “My Lead Sound” is now loaded.
4. Click on the Effect tab in the Navigation Bar to open the Effect window.
5. Click on the Effect Switch to activate the Effect:

The Effect Switch before activation.

6. Right next to the Effect Switch, you now see the so-called Effect Selector holding the list of available Effects, with a radio button next to each. Click on the last radio button, labeled Aetherizer:

→ This switches the Effect to Aetherizer. The bottom part of the Effect window shows you now Aetherizer’s settings.

Before we look at the Aetherizer-specific part, we will adjust the Dry and Wet Level controls in the Output Mixer, at the top of the window. These two knobs define the amounts of the dry (unprocessed) signal and wet (processed) signal sent to the effect output, respectively.
As for any knob of ABSYNTH 5’s user interface, you can modify their value by clicking them, dragging your mouse vertically while holding the mouse button depressed, and releasing the mouse button when you are satisfied with the value.

As we want here to listen to the pure Aetherizer, we adjust them as follows:
1. Set the Wet Level control to 0 dB (maximum, full right).
2. Set the Dry Level control to -96 dB (minimum, full left).

We are now ready to play with the Aetherizer.

### 4.5.2 Setting up the Aetherizer

Basically, the Aetherizer is a granular delay effect implementing a feedback loop on the grain level and sending the result into a post-delay section. If this sounds a bit cloudy to you, do not worry: this is all about grain clouds! Here’s what happens in the Aetherizer:

- It takes the sonic material coming at its input and chops it to little sonic grains, sampled at variable time and rate.
- Each grain gets tonally shaped by a pitch shifter.
- Each grain is then sent back through a feedback loop into the Aetherizer again.
- The overall result can then be filtered by either a Bandpass or Comb filter (depending on what you choose) and is sent out to the post-delay (which is itself endowed with its own feedback loop and Lowpass filter).

Worth noting is that at the predelay section each grain gets sent at a random position in the panoramic stereo field. And the good thing: all processing happening on the grain level can be randomized... and (of course) controlled via a modulation source, internal (Envelope/LFO) or external (Macro Control).

Enough theory, we now want to hear what this Effect can do. In order to understand it well, we’ll start by setting a few parameters as represented in the pictures below (we just set most of them at their minimum value):

The quickest way to define a bigger selection of parameter values is to click in each value display, enter the desired value with your computer keyboard and press [Enter].

![The initial settings for the Master section.](image-url)
The initial settings for the Grain section.

The initial settings for the Tone section.

At the bottom of the window, the Aetherizer display provides a stylized illustration of the grain cloud’s structure. It will be a great help for us to understand what is going on:
- On this display, you see a few tiny light blue triangles placed at regular intervals on the middle line. These triangles represent the grains of the cloud.
- If you look closer, you see a small light blue segment starting from each grain. This represents its size.

### 4.5.3 Playing with the Aetherizer

Starting to change the parameters progressively while carefully looking at the Aetherizer display and listening to the processed sound, we will get more and more familiar with this strange Effect.

To comfortably listen to the sound and notice the evolution, we recommend you to hold one note while applying the adjustments described below.

**Increasing the Grain Duration**

At the left side of the Aetherizer, the lower parameter in the Grain section is the Grain Duration. This parameter sets the size of each sonic grain.
- Increase the Grain Duration very slowly using the right diamond.
Look and listen:
- As soon as the grain size is bigger than 0, you start hearing a bunch of clicks. When the value gets around 1, the clicks start showing a tonal character. This tonal character gets more and more present as you continue raising the grain size value.
- By the way, you can see the grains grow on the Aetherizer display: the little blue segments get bigger and bigger.
  - Use the left diamond to increase the Grain Duration by bigger steps, always progressively.

Look and listen:
- As the Grain Duration value approaches 10, you hear the sound becoming continuous: the grains are now overlapping each other. As the parameter increases, the overall sound gets louder—also because of this overlapping.
- On the Aetherizer display, there is not much happening: the grains overlap each other, drawing a nice blue line in the middle of the display (in fact, the color gets more intense as the grains overlap more and more).
  - Stop the progression when the Grain Duration value is around 50.

Playing with the Transposition
On the right side of the Aetherizer, the upper parameter in the Tone section is the Transpose control. As it name implies, it controls the (pitch) transposition of the grains.
  - Increase the Transpose control a bit using the leftmost diamond (steps of one semitone).

Look and listen:
- You hear the sound transposed in a quite usual way.
- You see the grains going up on the Aetherizer display. You now understand that the vertical axis on the Aetherizer display represents the pitch of your grains!
Actually, a global transposition of all grains is very good for voice doubling and if detuned less than one semitone, for getting the same effect as detuning a copy of an oscillator but for the whole patch. This goes for using the Cloud filter on the Master Channel too. In our case, however, it might not be very interesting for the sound so do the following:

1. Set the Transpose control back to zero.
2. At its right, raise the Random Transpose control progressively.

Look and listen:
- This time, you get a nice chorus-like effect due to the slightly randomized pitch of the grains. When you raise the value above 10, you start hearing distinct pitches that make a more dissonant sound.
- On the Aetherizer display, you see a nice grain cloud expanding itself!

You can now use the Transpose control to set the overall pitch offset of the grain cloud.

► Stop the progression at a Random value around 50.

Further Adjustments
We can further densify the grain cloud by adjusting the Rate control, back in the Grain section. The Rate control defines how many grains are cut within one second:
- Raise the Rate control progressively until 200 Hz. Modulating the Rate is very similar to the modulation that happens in a Chorus.

Look and listen:
- You see the grains getting closer and closer.
- At some point, you cannot hear distinct pitches anymore, but a pile of sounds instead.

Right now, the sound might be a bit oppressive. To attenuate this:
- Set the Grain Duration back to a value around 25, thus diminishing the overlapping of the grains.
Do not hesitate to switch from time to time the whole Effect on and off via the Effect Switch at the top left corner, in order to hear the (huge) difference between the dry and the processed sound.

**Bringing the Filter into Play**

At the moment, our sound has a quite wide frequency range. Let us activate the Filter in the Tone section to shape the grains:

1. Activate the Filter by clicking on the Filter Switch:

   ![Filter Switch](image)

2. In the filter parameters that appear below, check that the Filter Mode menu is on $BP$.

Look and listen:
- On the Aetherizer display, the grains have changed color. This color illustrates the frequency content of each grain.
- You hear the sound filtered by a bandpass (hence $BP$ in the menu below the Filter Switch) with a quite large bandwidth.

Both parameters to the right of the Filter Switch control its cutoff frequency (Cutoff control, $Hz$) and its resonance (Resonance control, $Q$).

- Play with these parameters to hear how they affect the sound, without forgetting to play with their corresponding Random parameters.

   ![Filter Quantize](image)

   You can get for example some nice whistling sounds by setting the Cutoff control above 3000 Hz, its related Random Cutoff control somewhere below 60 and the Resonance control at a very high value.

- You can control which frequencies are randomly applied to the filter by turning on the Filter Quantize.

   ![Filter Quantize](image)

   Selecting a scale from the Filter Quantize menu will make sure that only certain frequencies are used in the filter’s randomization. The first parameter adjusts the center frequency. The behavior of Random Hz is: 0% - 50%, frequencies are progressively distributed across the template. Above 50% frequencies increasingly deviate from the template to become totally random.
We will leave you here, somewhere among the amazing possibilities provided by the Aetherizer—think that we did not try the Feedback control and the Predelay control nor any parameter in the Master section yet. Note that, in this quick tour, we deliberately used extreme parameter settings to let you grasp the range of possibilities. But in fact, the Aetherizer gives the best results when adjusting its parameters in a more subtle, sensitive way.

4.5.4 What Is Next?

This was only a brief introduction to what you can do with the Aetherizer effect (by the way, the Aetherizer is only one of the six available Effects in ABSYNTH 5). We invite you to play further with its parameters and to listen carefully to the way they affect the sound.

Next, one could think of many interesting things to do with it:

- Apply the Aetherizer on different audio material: We used here a rather simple continuous sound (our “My Lead Sound”), but the Aetherizer can produce terrific sounds on rhythmic material, for example. And why not try it on live audio input?
- Modulate! Almost every Effect parameter can be modulated by ABSYNTH 5’s internal modulation sources, or assigned to a Macro Control to control it from an external MIDI device or via the host automation. This can lead to very exciting results.
- You could use the Surround section, thereby enhancing the spatial presence of the Effect.
- You could also use the Cloud Filter (the little brother of the Aetherizer) on particular modules instead of applying the Effect on the Master Channel.

The Reference Manual will give you an in-depth explanation of the Aetherizer as well as all other ABSYNTH 5 Effects.

⚠️ When you have created a nice Sound using the Aetherizer and/or any other components, why not share it with other users? Go to the ABSYNTH User Library on the Native Instruments website: there you can upload your creations and download Sounds created by other ABSYNTH users. Get inspired!
Index

A
ABSYNTH 5 Library ............................................. 25
Aetherizer ......................................................... 50
Attributes ......................................................... 26, 29, 43, 51
AU ........................................................................ 11
Audio and MIDI Settings ......................................... 8
    ASIO .................................................................... 9
    ASIO Config ......................................................... 9
    Audio page .......................................................... 9
    Driver menu ......................................................... 9
    MIDI page .......................................................... 10

B
Basic concepts ..................................................... 12
Breakpoints .......................................................... 42
Browser ............................................................. 17, 26, 29, 43, 51
Browser Control Bar ............................................... 28

C
Channel
    Master ................................................................ 38
Comment Field ...................................................... 44
Compatibility ......................................................... 7
Computer keyboard ............................................... 10
Creating Sounds .................................................. 34

D
Damping control .................................................... 38
Database .................................................................. 40
Database view ........................................................ 26, 51
Driver ..................................................................... 9
    ASIO ..................................................................... 9
    Core Audio .......................................................... 9
    Driver menu ........................................................ 9
    Dry Level control ................................................. 51

E
Edit Anchor .......................................................... 48
Edit Anchors ......................................................... 49
Edit Anchors menu .................................................. 49
Edit menu ............................................................. 44
Effect ................................................................. 50
Effect module ......................................................... 12
Effect Selector ......................................................... 51
Envelope .............................................................. 13, 40
    creating ............................................................... 41
    Envelope display ................................................ 41
    Envelope List ....................................................... 41

F
FB tab .................................................................... 39
Feedback .................................................................. 38
Feedback Mode menu .............................................. 39
File menu ............................................................ 8, 10, 34
File Tree view ........................................................ 51
Filter module ........................................................ 38
Finetuning .............................................................. 15, 32
Frequency control .................................................. 37, 38, 39

G
Graphical user interface .......................................... 15

K
KORE SOUND ....................................................... 40

L
Latency ............................................................... 9
LFO ....................................................................... 13
Low latency .......................................................... 9

M
Macro Control ....................................................... 13
Main panel ........................................................... 39
Master Channel ...................................................... 12
Master Effect ......................................................... 50
Meta Information ................................................... 44
MIDI ........................................ 10,35
keyboard/controller .................... 10
MIDI notes .................................. 10
Mini-Patch view ......................... 31
Mix control ................................ 39
Modulation ................................ 13,40
Module
   Mini-Patch view ...................... 32
Module Slot ............................ 12,38
Morph page .......................... 47,49
Morph Wave .................. 14,45,49
Morph Wave Selector ............... 47,48
Mutation Amount slider ............ 30
Mutation button ...................... 30
Mutation History ..................... 33
Mutation History dialog ............ 33
Mutation section .................. 30
Mutator .................................. 15,44

N
Navigation Bar .......................... 16,34
New Sound ................................ 34

O
Oscillator .............................. 35,37
Oscillator Channels .................. 12
Oscillator module .................... 12

P
Patch window .......................... 12,34
Perform window ....................... 14
Plug-in
   Plug-inRTAS® .................. 11
Plug-in formats ....................... 11
Plug-in mode ......................... 11
Pro Tools ................................ 11

Q
Quick Starts ............................ 25

R
Randomization Amount slider ....... 30
Reference Manual .................... 6
Resonance control .................... 38
Retry button .......................... 31
Ring modulation ..................... 39
Sample rate ............................ 9
Search Field .......................... 28
Search Result List .............. 26,30
Setup
   Audio and MIDI Settings ........ 8,10
   Device menu ....................... 9
   MIDI Hardware .................. 10
   MIDI interface .................. 10
   Show menu ....................... 42
   Sound menu ...................... 28
   Sound Mutations ................ 29
   Sound Name display ........... 28
   Sounds
      loading and playing .......... 25
      saving ......................... 40
   Spectrum page ................... 14,47
   Stand-alone application .... 8
   Stand-alone version .......... 8
   System requirements .......... 7

T
Template Library ..................... 44
Transform menu ................... 47,48
Transition control .................. 49
Type menu .......................... 38

V
Virtual Keyboard ..................... 35
VSTi ..................................... 11

W
Wave display ......................... 48
Waveform ................................ 14,36
   creating ......................... 48
Draw Mode Tools .......................... 48
rasing ............................... 47
loading ............................... 48
morphing .............................. 45
naming .................................. 46
Waveform page ......................... 14, 47
Waveform Selection dialog ........ 36, 45, 48
Waveform Selector ...................... 36, 39, 45
Wave List ................................ 46
Wave Usage List ........................ 46
Wave window ........................... 14, 45
Windows ................................ 15
opening several ......................... 44